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Happy Thanksgiving to all GSCC Members 
and Friends! 

 

There is a cool breeze this morning, and it 
reminds me that before long, we will be in 
our Holiday Season —  Thanksgiving, 

Christmas, and the end of the year. There are only 2 meet-
ings left for our Club. At the November meeting will be 
shown  the browser “Opera”, and then there is our Christ-
mas Holiday Potluck and Silent Auction.  It goes so fast, 
faster all the time, it seems. 

 

You can look forward to new leadership at GSCC, even 
though a lot of the team will still be familiar faces. 

I want you to know that I thoroughly enjoyed being your 
President these past 3 years, and I got to know many of 
you wonderful people a little better. 

I will not be gone from the Club, it will just be easier to 
me to be absent once in a while.  (You all know that my 
retired husband and I like to travel…lol). 
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Your Club is healthy, has good membership, excellent leadership and teachers, good healthy 
finances, and offers so much to its members.  Take advantage ! 

And participate !  It is fun to share some of your knowledge with others. 

 

And now I wish you all a warm Thanksgiving Holiday with your loved ones. Appreciate 
every moment you have with them. 

 

Till next time, 

 

Annemarie 

Deleting Words (applies to Word versions 6, 97, 2000, 2002, 2003) 
Karen Tangeman, Big Bear Computer Club, CA Submitted by: Lucy Brejcha 
While editing documents, it is not uncommon to delete words, phrases, and the like. 
Different people take different approaches to the task. For instance, some people 
just select the text and press DELETE while others may simply hold down the DE-
LETE or BACKSPACE keys until the unwanted characters disappear. 
 
If you are in the latter group, and you spend a lot of time pressing DELETE or 
BACKSPACE, you may be interested in a handy shortcut provided by Word. All you 
need to do is hold down the CTRL key to speed up your deletions. Using 
CTRL+DELETE deletes text from the insertion point to the end of the next word. For 
instance, if you wanted to delete four words to the right, simply press 
CTRL+DELETE four times. Likewise, CTRL+BACKSPACE deletes words to the left 
of the insertion point. 
 
An interesting use of these shortcut keys is to speed up editing tasks, not just mass 
deletions. For instance, let’s say you wanted to change the word “sidestep” to 
“sideways.” Normally you would find some way to simply delete “step” and type 
“ways.” This could involve pressing DELETE or BACKSPACE four times to get rid of 
the unwanted portion of the word. You can make your edit faster if you just position 
the insertion point at the beginning of “step,” press CTRL+DELETE once, and then 
type “ways.” 

A Handy Shortcut (revisited) 
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2012 Membership Renewal Form 
To renew membership in the Glendora Seniors Computer Club, mail $12 (one year dues) with this form to: 

Attention: Membership 
Glendora Seniors Computer Club 
333 East Foothill Blvd. 
Glendora, CA 91741 
If there has been a change since you last paid your membership dues, please check the  

appropriate box.  

NAME _____________________________________________________________________________  

ADDRESS _________________________________________________________________________  

CITY_________________________________________________________     Zip________________  

PHONE NUMBER: ______________________________________________________  

EMAIL_____________________________________________________________________________  

LEVEL OF COMPUTER SKILLS (Please Circle) Novice  Average Expert 

Method of Payment:    Check     Cash 

PLEASE Paper Clip or Staple Your Payment to the Renewal Application before pay-
ing at the meeting. 

 Thank You For Supporting Your Club! 

MEMBERSHIP DUES ARE NOW BEING ACCEPTED FOR 2012 

To be a Member in good standing, dues must be paid by January 31. Print out the Renewal 
Application and bring it with you to any Club meeting except Dec. 14, or mail it to the ad-

dress below. 
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GSCC MEETING MINUTES 
October12, 2011 

President Annemarie Hunt opened the meeting at 1:00 pm welcoming all. 

President Hunt made the following Announcements:  

1) Bill Belcher is on vacation. 
2) $25 was given to Gaetano to replace sunglasses that disappeared the day of his pres-

entation. 
3) “GSCC Doing Our Thing” web site is not up yet. 
4) We have a candidate for Vice-President; need to fill other positions. 
5) Barbara Denny is taking care of 50/50 tickets; we have a few extra items to raffle to-

day. 
6) Please see Debbie to fill out Accident Forms for the La Fetra Center. 
7) Jim Glass will cover the SCRUGS meeting this Saturday (15th). 
8) There is a Board Meeting to follow today. 

 

Jim Glass read a proposed By-laws change: see attached.  A brief discussion of the reason 
for the change to comply with the name and use of the La Fetra “Community” Center; there 
will be a second reading next meeting before a vote. 

Thanked Al Gonzalez and Rita Norkin for cookies today. 

Program: Bob Gostcha gave a very informative presentation on Avaste a free antivirus 
program—“No such thing as a perfect antivirus program!”  Avaste provides removal tools 
and is a program that depends on participants finding and reporting problems.  85% of vi-
ruses come from websites; 6 out of 10 from “legitimate” sites.  In the past the behavior was 
for fun—now it is for money. 

 

Break:  

Sandy and Jeannine will bring cookies for the November 9th meeting. 

Education—Ell Fullmer and Jim Glass answered questions including:   
1) Internet security—specifically *72 Scam—DO NOT DO IT. 
2) Picture files. 
3) Windows Live Mail 
4) Non ISP accounts. 
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Classes: Continue on Tuesdays and Thursdays.  A Personal Calendar is program for October 
26 meeting.   

Other – The 50/50 drawing was won by Bill Hart.  Tshirt was won by Al. 
 

Next meeting – Wednesday October 26th.   

Meeting Adjourned: 3:00 pm  

Submitted by:        Approved By:  

Secretary Ruthann Mayrose     President Annemarie Hunt 

GSCC  MEETING  MINUTES 
October 26, 2011 

 

President Annemarie Hunt opened the meeting at 1:00 pm welcoming all. 

President Hunt made the following Announcements:  

1) Bill is in Las Vegas and Jim will do the planned program - ECalendars 
2) Proposed By-laws change – “seniors” must remain in the name of the GSCC; the only 

change will be in Article 2 to read:  “To help members of all ages solve computer 
problems.” 

3) The proposed class schedule for 2012 is classes on Thursday ONLY/no classes on 
Tuesdays.  Proposed classes include:  January/February – Getting the Most from your 
Digital Camera; March – That Damn Ribbon; April – Basic Computer Skills; June/July 
- Email & Internet.   

4) Nominations for 2012 Club Officers are still open. If interested in serving, email VP 
Connie Lang. 

5) Ell has tested the AVAST Program, and the link can be safely downloaded. 
 

Thanked Sandy and Jeannine for cookies today. 
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Program Chairman Jim Glass – a suggested meeting format for 2012 might include Spe-
cial Interest Group SIG, and/or Demonstrations by members of their favorite program or 
interest. 

Today’s Program: Jim demonstrated the use of www.eztocreate.com, a free website for 
creating greeting cards and personal calendars with your own pictures and dates: 

  1) Create a new folder,  

  2) Download and  

  3) “SAVE” not “RUN” the program. 

Annemarie shared possible solutions for dealing with “junk mail” and telemarketers, as 
well as telephone scams.  Donna spoke of a call claiming “You have won $1.6 million.” 

 

Break:  

 

Connie and Ruthann will bring cookies for the November 9th meeting. 

Education—Ell Fullmer answered questions including:   
1) VOX recording – voice to text and commented that Skype will adjust. 
2) Annemarie commented that the Samsung phone camera worked very well in a call 

from Austria. 
 

Other – The 50/50 drawing was won by Winifred Farrell. 
 

Next meeting – Wednesday Nov 9th.  Program “Opera Browser.” December 14th Potluck 
Party/Auction. 

Meeting Adjourned: 3:00 pm  

Submitted by:        Approved By:  

Secretary Ruthann Mayrose     President Annemarie Hunt 
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Why Do I Care? 

By Wil Wakely, President, Seniors Computer Group, CA 

October 2011 issue, Bits and Bytes 

www.scgsd.org 

Wilw31 (at) gmail.com 

This article might be a bit “techy” for some of us, but it is important to know a bit 
about what goes on inside of our computer so when something bad happens, we 
have a clue as to what might be wrong, and we can save time and money by not 
having to hire a high-priced technician to fix a simple problem.  

 First, let’s review the hardware. The power supply converts the house electricity, 
110 Volts AC (alternating current), to the appropriate lower DC (direct current) volt-
ages that the rest of the computer requires. It contains a fan to keep it cool, which is 
about the only noise you should hear.  

There is one large printed circuit board inside called the “motherboard”, because it 
contains connections, or “slots”, where other smaller “daughter boards” can be in-
stalled that do specialized functions. The motherboard is essentially the “head” of 
the computer and contains the major memory and connections for all of the other 
components. It has connectors for the keyboard, mouse, hard drives, modem, video, 
sound, fan and USB devices.  

It also contains the CPU (Central Processing Unit), a large computer chip which is 
the genius that runs everything. The latest versions of the CPU can do over three bil-
lion calculations per second, so it is really loafing most of the time. It is truly multi-
tasking which means that it can do a variety of things at the same time.  

So here’s what happens when you first turn on your computer and it “boots”. Boot-
ing comes from “bootstrapping”, or lifting oneself by his bootstraps. The computer 
needs to know some rudimentary facts about itself before it can come fully alive. 
This information is retained in a computer chip on the motherboard called a ROM 
(Read-only Memory), which permanently retains certain information without requiring 
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any power. There is a small disk-type battery on the motherboard which allows this 
ROM to be read. 

This battery also keeps the clock running while the computer is off, so if the clock 
time begins acting strangely, the battery may need to be replaced; however, it is usu-
ally good for years.  

This ROM contains the BIOS (bye-ose) which stands for Basic Input Output System, 
and instructs the computer where to find more information in order to fully start up. A 
process called POST (Power On Self Test) runs to test the memory and make sure 
the rest of the computer is healthy. It gives a series of Beep Codes to indicate the 
state of health. One beep means everything is okay. A Google search of Beep 
Codes will tell you what’s wrong if you get weird beeps while Booting. If you press 
the Del(ete) key immediately after pressing the start switch, a screen will show the 
BIOS settings, which can be modified if necessary.  Be careful!  

 

Hard drives are so important to the computer that it helps to understand how they 
work: Think of them like the old Juke-boxes – lots of LP records that each can be 
played with a moveable tone arm. The hard drive has hard metal platters, unlike old 
floppy disks which were flexible. They contain tiny magnetic spots which, depending 
upon how they are magnetized, indicate a one or a zero, which is the binary lan-
guage the computer understands. A moveable “head”, like the tone arm, “reads” the 
magnetic state of the spots, called magnetic domains, and “writes” to change the 
magnetic polarity. Rather than a spiral track like an LP, the hard drive has ever larger 
concentric circles called cylinder tracks. The platter is also divided up into sectors 
like pieces of a pie.  

So to find a file, the head moves to a specific cylinder track and sector and reads the 
data that is there. A large table of contents, called a Partition Table, contains the 
track/sector location of all the files. Obviously, if this table becomes corrupted, the 
files cannot be located. Fortunately, a backup copy is automatically retained. How-
ever, if the hard drive dies, this backup copy is useless. (Backup! Backup! Backup 
elsewhere!) 

While booting, the hard drive is recognized, and a small area at the front of it is de-
fined as the MBR, Master Boot Record. This contains enough information about the 
hard drive to locate the OS (Operating System) like Windows and load it.  
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The OS has its own sub-conscious memory called the Registry which contains a 
wealth of information about the computer and files. This now loads and can take 
quite a while if it is large. If this Registry file or the MBR gets corrupted, it is a major 
problem. Fortunately, backup copies are automatically maintained.  (Backup! 
Backup! Backup!)  

  Now we are almost home free. The next thing that happens is to load the StartUp 
files. These are programs that start automatically when you turn on your computer. If 
there are a lot of these, it can drastically slow down the boot time. You can see and 
change these Startups by typing “run msconfig” and clicking on the StartUp tab. 
Check or uncheck the programs you desire. Keep these to a minimum for faster 
booting.  

 At this point Windows should be running, and you are a happy camper to have full 
control. As you can see, lots of things happen before you are allowed at the controls, 
and all it takes is a minor glitch in any of these booting processes for your computer 
to fail to boot. It’s amazing that it works at all!  

Frequent backups of your hard drives are the solution to major computer head-
aches. It is not a case of ‘if’ your computer crashes, it is ‘when’.   

Happy computing!  

***** 

The Graphics Side of Word, Part 1 

By Nancy DeMarte, Columnist, Office Talk, Sarasota PCUG, Inc., Florida 
May 2011 issue, Sarasota PC Monitor 
www.spcug.org 
ndemarte (at) Verizon.net 
 

It is natural to think that a word-processing program would deal only with words. Cer-
tainly, most commands in Microsoft Word do relate to editing or formatting text. But 
each new version of Word has introduced more ways to enhance text with graphical 
elements like clip art and photos. This article and the one next month will deal with 
the graphics side of Word 2007 -- what the options are and how to use them within a 
Word document. Many of these techniques apply to Word 2003 as well; all apply to 
Word 2007 and 2010. 
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This month the focus will be on the types of graphics that may be inserted within a 
Word document and how to insert them successfully. To do this, we need to explore 
the Illustrations group within the Insert tab in Word 2007. 

Inserting Pictures 

Since a picture is worth a thousand words, often adding a photo to a document helps 
clarify its meaning. To do this, open a Word document and place the cursor on the 
page where you want a photo to appear. Double-clicking in any blank space inside 
the margins will position the cursor at that spot. Click the Insert tab - Picture. Your 
Pictures folder will open, allowing you to select a photo from your collection. Click 
the photo, then click Insert to make the photo appear in your document. Depending 
on its size, the photo may fill the screen, blocking out the text, or jump to the next 
page. Instead of panicking, find one of the corners of the photo and drag it toward 
the center to reduce its size while maintaining its proportions. When the photo 
reaches the desired size, right click it and select Text-wrapping - Tight or Square 
from the menu. This will allow the photo to be moved around and positioned within 
the document with text surrounding it. You can experiment with other text-wrapping 
choices if you want the photo positioned differently, such as behind the text. Some-
times Text-wrapping is not visible in this menu. Choose Format Picture instead, then 
Layout, to get the text-wrapping choices. 

 

When you select  the photo, now you will notice that a new tab called Format has 
appeared in the ribbon at the top of the screen with the phrase Picture Tools above 
it. Click Picture Tools to reveal commands related to editing and formatting the 
photo. These tools allow you to brighten or crop the photo, add borders and effects, 
and change its position or size. When you deselect the photo, notice that the Format 
tab and Picture Tools disappear.  

 

Inserting Clip Art 

Office 2007 has extended the definition of Clip Art to include not only the standard 
drawings and photos, but also movies and sounds. There are thousands of these 
items which can be inserted into your documents. Open your document and click the 
Insert tab - Clip Art. Fortunately, the Clip Art dialog box, which opens along the right 
side of the screen, contains a powerful search feature. Begin by entering a search 
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term, like "birthday cake." Then, using the drop down menus, choose whether to 
search just on your computer, the Microsoft Office website, the whole web or all of 
these (best choice). You can also choose which kind of media you want to search, 
such as clip art or sounds only. With a fast Internet connection, it takes only a couple 
of seconds for the Clip Art search box to return items which meet your search criteria 
after you start your search.  

 

To add a clip art item to your document, merely drag it from the Clip Art box to your 
document. To add more than one item at a time, hold down the Ctrl key while you se-
lect items, then drag the whole group together. Once the clips are in the document, 
follow the same general instructions for resizing, text wrapping, and moving as you 
did for photos. A Help command at the bottom of the Clip Art box can help you solve 
any problems you encounter. You may close the clip art dialog box when finished 
adding clips. 

 

Inserting Shapes 

Older versions of Word had a Drawing toolbar which gave access to a few shapes 
and tools for working with them. Word 2007 has made a noticeable improvement in 
the number of available shapes and how shapes are organized. On the Insert tab, 
click Shapes in the Illustrations group to open the expanded gallery. Click the shape 
you want, but don't expect it to appear instantly in your document the way a photo 
does. Instead, you must click inside the document where you want the shape to ap-
pear. Hold down the left mouse button and drag any direction to make the shape visi-
ble. Once it's there, it can be resized by dragging one of the "handles" (small squares 
along the edge) and moved the same way as clip art. Right-clicking the shape gives 
you a menu of options similar to those for a photo or clip art.   

 

If you select the shape in your document, the Format tab appears again but with new 
commands. Click Drawing Tools to see ways to enhance your object. For example, 
you can choose fill colors, effects, and arrangements of multiple objects. 

If you are designing a complex arrangement of shapes, you may wish to use the 
Drawing Canvas tool which is found at the bottom of the shapes gallery. This tool cre-
ates a large area in which to put multiple graphic elements to create a complex draw-



ing. The canvas keeps objects from moving around unexpectedly, but can be difficult 
to control.  

 

A simpler way to work with multiple objects is to use the tools found in the Arrange-
ments group in Drawing Tools. One command lets you move an object to the front or 
back of the arrangement; another lets you rotate an object. An especially useful com-
mand is Group, which is a simple way to put objects together. First arrange the ob-
jects in your document. Then, while holding down the Ctrl key, select all the shapes 
you need. Click Drawing Tools - Group - Group to merge them so they are treated like 
one object. If you want to split them apart, click Group - Ungroup. 

 

These three types of graphic items -- pictures, clip art, and shapes -- were part of ear-
lier versions of Word. They were improved in Word 2007 by offering more choices and 
better organization of tools. Next month we will continue with a look at a new graphic 
feature introduced in Word 2007 called Smart Art, plus the improved Charts element, 
and some ways that text can become art as well.  

***** 
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 Degunking Windows 7 

By George Harding, Treasurer, Tucson Computer Society, AZ 

October 2011 issue, eJournal 

www.aztcs.org 

georgehardingsbd (at) earthlink.net 

 

The book is written by Joli Ballew, an author (36 books!), trainer and web site man-
ager . She has written for the McGraw-Hill “How to Do Everything” series. The book 
has 273 pages, including an extensive Index of 19 pages. The theme of the book is 
how to easily clean up your PC and speed it up. The process does not involve any 
special tools. All you need is already contained in Windows 7. If you are running XP, 
Vista or 2000, many of the tools you need are available in those programs as well. A 
few are only in Windows 7 
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The author has developed a 12-step process for degunking your computer. Here it 
is: 

1 . Get rid of files and programs you don’t need. 

2 . Organize the remaining files and folders. 

3 . Clean up your desktop, Start menu and Task Bar. 

4 . Optimize your hard drive and limit the programs that run in the background. 

5 . Clean up and secure Internet Explorer and consider alternate web browsers. 

6 . Reduce e-mail spam, back up e-mail and organize e-mail. 

7 . Install Windows updates and reconfigure anti-virus, anti-malware and anti-adware 
programs. 

8 . Clean up your network and create a home group. 

9 . Fix problems with media, including duplicate files, files that won’t play and files 
that are taking up hard drive space unnecessarily. 

10 . Optimize syncing with cell phones, music players, iPads, iPhones, netbooks and 
laptops. 

11 . Get rid of errors for hardware, the operating system and third-party programs. 

12 . Create a working, reliable and fool-proof backup system. 

 

She realizes that not everyone can afford the time or is interested in doing every one 
of the steps. To address that, she has developed 10-minute, 30-minute, one-hour 
and half-day programs. These capture the most significant actions that will give the 
most benefit for the time allotted. 

 

The first step is probably the most difficult and time-consuming, because you pretty 
much have to look at a lot of the document, pictures and media files to determine 
what can be trashed and what must be saved. If you click on the Change My View 
button (in Documents or any folder) and select Details, simply click on the Date 
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header to sort by date and see the oldest files. These may be the most likely ones to 
delete. 

If you press the Delete key or right-click and select Delete, the file will be moved 
from its current location to the Recycle Bin. This is just a different location on your 
hard drive, which you can empty from time to time. To permanently delete a file, hold 
down Shift while you delete. 

Getting rid of unused and unwanted programs can be easily done through Control 
Panel/Programs. Here, you can uninstall those programs you no longer need and 
those you didn’t know you had. While you’re there, note on the left side of the frame 
the option to turn off Windows components. Here, you can turn off or on various Win-
dows components. 

The last thing to do to clean things up is to run Disk Cleanup. In the Start menu 
Search window, type “cleanup” and click on “Free up Disk Space.” 

When the analysis is done, you see a list of types of files and the amount of space 
that would be freed up by deletion. Check or uncheck as appropriate and click OK . 

You can organize your files by creating folders inside the major system categories. 
For example, to organize your client letters, create folders in the My Documents 
folder for each client and save files in each for your clients. Likewise, for pictures, 
classify your photos by creating a folder for each trip or subject. You’ll be able to find 
the pics you need much more easily this way. 

Lastly, defragment your hard drive to reorder and reconnect the files you’ve moved 
and deleted. Right click your drive in Windows Explorer, choose Properties, then 
Tools . Click Analyze to see if defragmenting would be advantageous. You can also 
adjust the scheduled defragmentation that’s currently set up . 

You should clean up your Desktop by deleting any icons and shortcuts you don’t 
use. You can put a shortcut on the Desktop for Computer or Network by browsing to 
that folder and right-clicking. Choose Send To/Desktop to create a shortcut. 

You can customize your Start menu by right-clicking the Start icon and choosing 
Properties, then click on Customize. I like the Recent Items choice because it avoids 
having to first launch an application, then open the document I want to continue with. 
You can also pin items to the Start Menu or Task Bar by right-clicking and selecting 
Pin to Start Menu or Pin to Task Menu. 



November 2011 Page 15 

The author points out several things you can do to optimize your hard drive: convert 
to NTFS (assuming you’re still on FAT), run Check Disk (under Properties of your 
drive), run Performance tests, run Disk Cleanup. 

One of the most powerful enhancements is in Performance in Control Panel. Here 
you can adjust visual effects, control indexing and change system settings. 

There’s a chapter on IE8, including how to turn on Compatibility View, remove tool-
bars and add-ins, explore privacy and security settings. 

 Chapter 8 deals with email, how to organize it, filter it and how best to deal with 
spam. It also shows you how to back-up email lists. 

Chapter 9 deals with the important subjects of security, Windows Update and the use 
of firewalls and other security packages. 

The balance of the chapters deal with less crucial subjects. They may be of interest 
to some users, but probably not all. 

I found this book to be useful. I tried out many of the ideas both to see how they 
worked and to see the improvement that might result.  

About: Degunking Windows 7 

Author: Joli Ballew 

Publisher: McGraw-Hill Osborne Media 

http://www.mhprofessional.com/category/?cat=2834 

ISBN-10: 0071760059 

ISBN-13: 978-0071760058 

Price: $25, $16.50 @ Amazon 

**** 

The Computer Guys, Bill Belcher & Ell Fullmer, will be meeting on the  

SECOND Thursday of the month:  

November 10th 

9:00 a.m. to 12 noon — Second Floor — La Fetra Center 
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Ask Mr. Modem! – November 2011  
www.MrModem.com  
 
 
Destroy Old CDs 
 
Q. I have an old magnetized eraser for 5.25-inch floppy disks. Can I run some old CDs I 
want to destroy through it or is there a better way to destroy CDs? 
 
A. The best way to destroy old CDs or DVDs is to physically destroy them. I usually give 
them one slash across the playing surface with a box cutter or a quick snip with pruning 
shears. It's very fast, but very permanent. 
 
 
Q. I notice that you have been responding to a number of questions in your last few col-
umns about the Apple iPad. Thank you for providing this information. I've been think-
ing of getting one, but wasn't quite sure. Do you have one and is it everything that it's 
cracked up to be? 
 
A. Yes, and yes. I do have an iPad 2, with the optional 3G (wireless) service, and it definitely 
lives up to the hype. Mrs. Modem, who isn't a big computing enthusiast (she's 5' 1”), recently 
purchased one, and her impressions are typical of most users:  
 
She is particularly impressed with how easy it is to use, how simple it is to install programs 
(called applications, or apps for short), and she loves that she doesn't have to fuss with anti-
virus or anti-malware protection. While she replaced her desktop computer with the iPad, 
that's not something every computer user will want to do, but in her case, she primarily used 
her computer for email and visiting Web sites, so the iPad was an excellent replacement.  
 
A free app also allows her to read Kindle and other ebooks, so she also saved the price of a 
Kindle. In fact, her enthusiasm for her iPad is the reason I wrote the Pulitzer-lacking ebook 
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series, “Mr. Modem's Top 50 iPad Tips” available on amazon.com.  
 
To view all my humble-yet-fabulous literary offerings, go to amazon.com and search for “Mr. 
Modem.” Behold the miracle of the ebook! 
 
Q. In the upper right-hand corner of my keyboard is a key marked "PrtSc/SysRq." 
Someone told me if I want to print a map, for example, to put it on the screen, press the 
F11 key, then hold down the other key and the Shift key to print a full-sized map. Can 
you elaborate on this? I don't understand it at all. 
 
A. F11 switches into full-screen mode for most browsers, allowing more of a page to appear. 
Pressing the Print Screen (PrtSc/SysRq) key captures the current screen and places it on the 
Windows Clipboard. You can then use any graphics editor (Paint is fine, located within Win-
dows, under Accessories) or word processor and paste (by pressing CTRL + V) the saved im-
age onto the screen and print from there.  
 
Historical Footnote: The SysRq or SysReq key, which shares your PrtSc key is a relic from 
another era -- not unlike Mr. Modem. Short for “System Request,” unless specifically pro-
grammed for a particular application, today the SysRq key is as useless as a Kardashian at a 
MENSA meeting. The SysRq key doesn't appear on most new keyboards.  
 
Q. This may be a silly question, but can you tell me the difference between a CD and 
DVD? 
 
A. Other than the spelling (sorry, I couldn't resist), there are a number of technological differ-
ences between the two, but from a user perspective the primary difference is capacity. DVDs 
can hold far more data than CDs. 
 
A typical CD can hold 700MB (megabytes), while a single-layer DVD can hold 4.7GB 
(gigabytes), more than six times the amount of data. While CDs are primarily used for data 
and audio, DVDs are primarily used for video. 
 
Mr. Modem’s DME (Don’t Miss ‘Em) Sites of the Month  
 
Answers.com 
A free, online reference guide with information covering more than a million topics. It's 
enough to make your head explode. The site's editors draw their data from a myriad of 
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sources, including dictionaries, thesauruses (thesaurii?), encyclopedias, and atlases.  
www.answers.com 
 
Bookshare.org 
Provides access to more than 125,000 digital books for the visually impaired. Works that are 
out of copyright are available to anyone; books that are still under copyright are available ex-
clusively to Bookshare members. Individual, all-you-can-read, subscriptions are $50 per year 
and you must provide proof that you have a “print disability” that prevents you from reading 
regular books.  
www.bookshare.org  
 
Compendium of Lost Words 
Philologists and lexicographers will love this collection of hundreds of obscure and rare words. 
In order for a word to qualify for inclusion, it must be found in the Oxford English Dictionary, 
but it must not appear anywhere on the Internet -- except, apparently, on this Web site. A few 
minutes perusing Forthright's Phrontistery will transform visitors from humble wordsmiths to 
knowledgeable, hypenemious aretalogers -- and you can quote me on that. 
http://phrontistery.info 
 
“Mr. Modem's Top 50 Computing Tips,”a life-altering five-ebook series, is just a 
download away on amazon.com! Each volume features 50 of Mr. M.'s greatest computing 
tips, all easy to understand, all written in Mr. Modem's entertaining and occasionally in-
formative style. 

 

Thanks for bringing cookies 
to the October 12th meeting 

Rita Norkin 

Al Gonzalez 

Thanks for bringing cook-
ies to the October 26th 

meeting 

Sandy and Jeannine 

 “Give a man a fish and he will eat for a day.  

Teach him how to fish, and he will sit in a boat 
and drink beer all day.” 

Confuse us say: 
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DO YOU HAVE A QUESTION FOR OUR TECH GUYS, BILL BELCHER & ELL FULMER? 

Fill Out the Form Below & Bring it to the Meeting 

 

Name: ______________________________________________________________________________________________ 

 

Cptr Operating System      Windows 98   ___  Windows XP   ___  Windows Vista  ____ Windows 7 ______ Mac___ Other____ 

 

Question:_________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

_________________________________________________________________________________________________________ 

 

 



 

333 East Foothill Blvd. 
Glendora, CA 91741  
Telephone: (626) 914-8235 

All opinions herein are those of the individual authors only, and do not necessarily reflect the opinion of the GSCC. The GSCC does 
not endorse, rate or otherwise officially comment on either products, services or vendors. Readers are cautioned to rely on the opin-
ions presented at their own risk and discretion.  

The GSCC, its editorial staff, and its contributors assume no liability for any damage arising out of the reliance upon any published 
article. 

Articles are compiled without verification of accuracy or applicability of accuracy or applicability of any article. 

We’re On The Web  
Webmaster:  
Ell Fullmer 

www.gscclub.org 
Email:  

gscc(at)gscclub.org 

Elected Officers 

Committees & Chairpersons 

Have a New  

Email Address?  

Please Notify Membership 
Chair: Jeannine Foote  

jeanninefoote(at)
yahoo.com 

Thank you to the following mem-
bers for help in this   

 month’s Newsletter:: 

Glen Moore  

  

  

 

Program Director            Jim Glass  jglass1001(at)aol.com 

Asset Management       Glen Moore mooretours(at)earthlink.net 

Membership  Chair      Jeannine Foote  jeanninefoote(at)yahoo.com 

Public Relations        Donna Hinman amegachi(at)gmail.com 

Nominations                

Programs Chair            Jim Glass jglass1001(at)aol.com 

Webmaster                     Ell Fullmer pakratt(at)gmail.com 

Education                       Bill Belcher billbelcher(at)gmail.com 

Newsletter Editor     Dan Leddy ranchitoave(at)yahoo.com 

Set-Up Chair                   Bill Hart Bobbibill(at)peoplepc.com 

Please submit Newsletter Arti-
cles by the last Friday of the 

Month.  

Type GSCC in Subject Line. 

Email to Dan Leddy 

ranchitoave(at)yahoo.com 

President                Annemarie Hunt ajhunt1447(at)aol.com 

Vice President Connie Lang connielang(at)verizon.net 

Secretary Ruthann Mayrose Ruthannmeister(at)gmail.com 

Treasurer                Rose Marie Diem catscobwebs(a)charter.net 

Tech Advisor  Ell Fullmer pakratt(at)gmail.com 

Past President—Annemarie Hunt Ajhunt1447(at)aol.com 


